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Copyright
©2002 Premier Assistive Technology, Inc. All Rights Reserved. This
documentation and the accompanying software are copyrighted materials.
Making unauthorized copies of this material is prohibited by law. No part of the
software or documentation may be reproduced, transmitted, transcribed, stored in
a retrieval system or translated into any human or computer language without
prior written permission of Premier Assistive Technology, Inc. Premier Assistive
Technology, Inc. asserts its "Moral Right" to be identified as the author of this
work, in all jurisdictions which recognize the "Moral Right."
Notice

UNLESS OTHERWISE PROVIDED BY WRITTEN AGREEMENT WITH
PREMIER ASSISTIVE TECHNOLOGY. THIS PUBLICATION, AND THE
SOFTWARE SOLD WITH THIS PUBLICATION ARE PROVIDED "AS IS"
WITHOUT WARRANTY OF ANY KIND EITHER EXPRESSED OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR THIS
PARTICULAR PURPOSE. THE ENTIRE RISK ARISING OUT OF THE USE
OR PERFORMANCE OF THIS PUBLICATION AND SOFTWARE REMAINS
WITH YOU. IN NO EVENT WILL PREMIER ASSISTIVE TECHNOLOGY
INC., OR ANY OF ITS SUPPLIERS, BE LIABLE FOR ANY LOST PROFITS,
LOST SAVINGS, DIRECT, INCIDENTAL OR INDIRECT DAMAGES OR
OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES, EVEN IF
PREMIER ASSISTIVE TECHNOLOGY, INC, OR ITS SUPPLIERS, HAVE
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. PREMIER
ASSISTIVE TECHNOLOGY, INC. RESERVES THE RIGHT TO MODIFY
THIS DOCUMENT AT ANY TIME WITHOUT OBLIGATION TO NOTIFY
ANYONE. IN NO EVENT SHALL PREMIER ASSISTIVE TECHNOLOGY,
INC. OR ITS SUPPLIERS' LIABILITY UNDER THIS AGREEMENT EXCEED
THE SUM OF ANY AMOUNTS PAID HEREUNDER BY THE CUSTOMER
TO PREMIER ASSISTIVE TECHNOLOGY, INC. OR THE SUPPLIER.

Trademarks

These other marks include, but are not necessarily limited to: WINDOWS,
WINDOWS 98, WINDOWS NT, and WINDOWS 2000, WINDOWS ME,
WINDOWS XP, which are registered Trademarks of Microsoft Corporation.
You shall not use any of the Trademarks or Service marks of Premier Assistive
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Technology, Inc., or Microsoft Corporation, or any other entity, without the
express written permission of such Trademark or Service mark owner.
Deletion or Modification

If any portion of this Manual, including but not limited to the "Notice" section
above, is held to be unenforceable, then that portion shall be deleted, and the
remaining language shall be given its broadest legal effect.

Premier Assistive Technology, Inc.
13102 Blaisdell Dr.
DeWitt, MI 48820 USA
Phone: 517-668-8188 Fax: 517-668-2417
E-mail: info@readingmadeeasy.com
Web: www.readingmadeeasy.com
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HOT Key List
General Hotkeys
Open
New
Save
Print
Close
Editing Hot Keys
Cut
Copy
Paste
Select All
Visual and Special Hotkeys
Highlight Selected Text
Extract Highlighted Text
Quick Zoom
Insert A Bookmark
Move To Prior Bookmark
Move To Next Bookmark
Reading Hot keys
Read
Stop Reading
Read a Word at a Time
Spell Word
Help
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CTRL+O
CTRL + N
CTRL + S
CTRL + P
Alt+F4
CTRL + X
CTRL + C
CTRL + V
CTRL + A
CTRL + H
F3
CTRL + Q
F9
CTRL+F7
CTRL+F8
F6
F7
CTRL + Right/Left Arrow
Left or Right Arrow
F1
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Who is the E-Text Reader designed for?
The E-Text Reader is designed to help those who have trouble reading or comprehending
the printed word. There are thousands of literature titles now available in electronic
format. This is great, but if you have trouble reading, electronic formats will be just as
difficult to read as hardcopy. To solve this problem we developed the E-Text Reader.
This reader will read (using digital voices) the electronic version of books (“E-Books, or
E-Text”) to you. The E-Text Reader can read any document in Standard Text, MS Word,
RTF (“Rich Text Format”) and HTML formats. This E-Text Reader will help anyone
who needs documents read to them.

The E-Text Reader goes beyond just reading. With E-Text Reader, you can highlight text
for notes or just for points of interest. The built-in highlighter let you select the text you
want to highlight and then select the highlighter and the text will be highlighted. The
multiple colors of highlighters allow you to easily make notes in the document. E-Text
Reader will also allow you to type your own notes right in the document.
How many people can finish a lengthy novel like “War and Peace” in a single setting?
Virtually no one can and that is why we have given you the ability to insert bookmarks.
You can insert as many bookmarks as you want. These bookmarks can be saved and
when you open the document you can quickly navigate from bookmark to bookmark and
find exactly where you left off.

E-Text Reader Features
Use the E Text Reader to read Text, MS Word, HTML and Rich Text Format documents.
1. Compatible with multiple File Formats including: Standard Text, MS Word (All
Versions”), HTML and Rich Text Formats.
2. Cut and Paste “to” or “from” any program.
3. Highlights and tracks each word as it reads.
4. Change Foreground and Background colors.
5. Adjustable Reading Speeds.
6. Reading pace. Read one word at a time or continuously.
7. Bookmarks. Insert bookmarks to mark locations in the text.
8. Highlighting Features. Use the built-in highlighters to highlight text for studies
and review.
9. Highlight Extraction. Use the extraction feature to extract only highlighted
information (even multiple colors).
10. Extract Highlighted Text by Color. Users can extract all highlighted text or only
one color.
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11. Read only Highlighted Text. E-Text Reader can be directed to read only
highlighted text.
12. Change Fonts. You can change the fonts to any one you want. The default is
Arial but you can change it to any font on your computer.
13. Zoom. No more fine print. Magnify the document up to 4X or change the font
size to 48 Point.
14. Audio books. Bookmarks are compatible with Text-to-Audio when creating audio
books.

About The E-Text Reader
The E-Text Reader is designed to be a reading tool. You can use it for opening up and
reading existing documents in your computer or you can cut and paste from any program
on your computer. You can even insert pictures into the text. It is an “easy to use”
reader that gives you the ability to change voices, read at any speed, and even allows you
to make notes into the document you are reading.
Since the interface is actually a word processor, you can select and highlight text just like
you would use a highlighter in a regular book. You can also insert any number of
bookmarks. You can save these bookmarks with the documents so the next time you
open it you can quick go back to a point of interested or to where you left off. In
addition to highlighting and bookmarks, you can “underline” and “bold” text so that they
can be easily identified.
Everything in the E-Text Reader can be controlled with hot keys or Icons on the toolbar,
making it easy for everyone to use. We have also built-in the electronic manual so that
the E-Text Reader can read the manual to you.

Creating a Summary of you document
The E-Text Reader has a built in document summarizer feature. This feature allows a
reader to reduce the contents of the document to its basic essentials. A language modeling
system is used to do the summary, giving it a higher degree of accuracy over the formula
driven models used in the summary feature of Microsoft Word. Because Premier uses
language, modeling the summary will even be effective on fiction that does not always
have the formal paragraph structure used in non-fiction writings.
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How to summarize a document
The summary feature is built into the E-Text Reader, so you must start the E-Text
Reader. Once the E-Text Reader has loaded, open your document. Once the
document is displayed, you will see the tool bar.

.
The icon on the far right of the Support Toolbar is the Summarize icon
You can select this icon for select Summarize from the edit menu. This will open
up the summarize window.
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You have two choices of how you want the summary; you have one or the other
or both. They are Place Summary into a separate document, and Highlight
Summary in the original document.

Place Summary into a separate document.
When there is a check in the Place Summary into a separate document, a separate
document is created and the resulting summary is placed in it. This summary can
be saved or read independently of the original document.

Highlight Summary in the original document.
When the Highlight Summary in the original document has a check mark in it, the
summary sentences will be highlighted in the original document. When the
summary is done, you will be able to look at the original document and see
exactly where the sentences that were pulled into the summary came from.
There are four choices of colors that can be used by the summary. These colors
are Yellow, Blue, Pink and Green. These are the same colors used by the
highlight and extraction feature built into the E-Text Reader. This gives you a big
advantage over other summary tools because once the summary is done you can
go through, and add things to the summary, just by selecting the text you want to
add and then click on the high light color. To remove text from the summary
select the highlighted text you want to remove and then select Clear Highlights
from the Edit menu.
This is the first summary tool that allows you to quickly modify the summary. If
you want, you can have the Summary Highlight in one color, and then switch
colors for your highlight, that way you will be able to easily distinguish what was
in the original and what was not. Once you are done highlighting and you would
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like to create a separate document that contains just the summary use the Extract
feature on the Support Toolbar.

Adjusting the summary size
You can control the size of the summary. For some documents, you can create a
summary that is only 10 percent of the original document and some you will need
a larger summary. Adjusting the size of the summary will take a little practice to
meet your needs. To help with this you have two options, you can restrict the
summary to be a percentage of the original document, or it can be a specific
number of sentences.

The default setting is a percentage of the document. To switch between
percentages of the document to number of sentences just select the desired radio
button. Once you have made your selection, you can adjust your summary size.
You adjust the summary size simply by moving the slider to the left to make it
smaller, and to the right to make it larger. Just below the slider, you will see the
percentage or the number of sentences that will be included in the document.
When you have made the selections for your summary just select the Summarize
button and it will start the summary. The summary process is pretty fast it can
summarize about 10 pages a second, so a 100-page document will take about 10
seconds.
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Installing
System Requirements:
The following are the recommended system requirements for Talking Word Processor©:
•
•
•
•
•
•
•

Operating System: Windows XP Home/Pro Vista.
Memory: 256 MB of RAM
CPU: 500 MHz or Faster
Storage: 45 MB of Free space
CD ROM Drive: 4X or Faster
Sound Card with Speakers
Keyboard and Mouse

The E-Text Reader
The E-Text Reader has three main sections. The Menu, Toolbar and reading area. Every
main function of the E-Text Reader can be controlled from menus. We have added “hot
keys” and Icons on the tool bar for the most common Functions. The E-Text Reader can
only have one document open at a time. The title of the open document is always
present in the title bar of the E-Text Reader. If no document is open, the title bar will
only say “E-Text Reader”
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Translations
The E-Text Reader can translate to and from 8 different languages. The process
is simple. Just open up a document or cut and paste some text into the E-Text
Reader, then go to the translation menu and select “Translate”. Select the
language that the document is currently written in, then select the desired output
language, and click on the translate button.
When the translation is done, a new window will open with the translated text.
This document can be saved or read.

Translations Supported
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

English to Spanish
English to French
English to Italian
English to Portuguese
English To German
English to Japanese
English to Korean
German to English
German to French
Spanish to English
French to English
French to German
Italian to English
Portuguese to English
Japanese to English
Korean to English

New Document
To create a new document, press CTRL + N or go to the File menu and select
New. Selecting New will clear the screen of any text. If you want to save the
information on the screen, you must save the information prior to selecting New.

Opening a Document
The E-Text Reader can open up virtually any type of word processing file. It can
read Microsoft Word Documents, Rich Text Formats, standard text files and

E-Text Reader

13

HTML. To open a document, go to the file menu and select open or click on the

Open icon

. This will open up the standard Windows Open dialog box.

Select a File Type
Select the file type that you want and then select the file you want. Click on the
Open Button and it will open the document in the Reading Window.
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Saving a Document
There are two ways to save a document: (1) Save or (2) Save As. If you have
opened an existing document, you can use the Save feature. You will not be
prompted for a file name. If you have not given the document a name yet, when
you go to save, it will prompt you for a file name and file type
It is important to note if you save a document as a standard ASCII file, which is a
text file, all formatting will be lost. The bookmarks will remain, but the formatting
will be removed. If you have highlighted or changed text in the document, you will
want to save the document as a Word Document or in a Rich text Format.

Save
To save changes to a document, hold down CTRL+S, or slect the save Icon from

the toolbar
. You will only be prompted if an error occurs when you are
trying to save a document. If no message is displayed, the file has been saved
successfully. If you try to save a document and have not yet given it a name, you
will be prompted to do so with the Save As dialog box. See the Save as dialog
box in this section for more information. There is also an icon below the menu
bar of a black diskette, clicking on this will save any changes made to the
document.

Save As
You will see the Save as dialog box in two different situations. One is when you
have created a document, but have not saved it yet. When you save a document
for the first time, you must supply a file name, file type and a file location. By
default, when you create a new document it is given the name “Untitled”, the file
type is Microsoft Word, and the location is “My Documents”. If the location and
the type are OK, all you need to do is type in a file name. The name can be up to
255 characters long and be any combinations of letters and numbers. You do not
need to put an extension on the file (e.g. .doc or .txt); the system will
automatically do this for you based on the type of file selected.
If you attempt to give the file a name that already exists, you will get a prompt
asking you if you want to overwrite the existing one. If you select “Yes” the old
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file will be gone.
You can also use the Save As to copy files. You can open a document and then
go to File, select Save As and give the document a new name. It does not remove
the old file; it only makes a copy of it.

Close
There are safeguards built into the Close feature. If you try to close a document
that you have made changes to, you will be prompted to save the changes. If you
have not given the document a name, the Save As dialog box will appear,
prompting you to give the existing document a name. See the Save As section of
this manual for more information about the Save As function. A hot key for this
feature is CTRL+F4.

Edit Menu
The Edit menu is only available after you have opened or created a new
document. On this menu you will find what you need to manipulate text, such as
Cut, Copy and Paste.

Highlight
The E-Text Reader has a built in highlighter. When you press CTLR-H or click
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on the
highlight icon. Whatever text you have selected will be
highlighted. This is a nice feature if you are studying and need to highlight
important parts of a document. There are multiple highlight colors to pick from.

Highlight Colors
The E-Text Reader has 4 different highlight colors to pick from: Yellow, Green,
Pink and Blue. The color that has the check mark next to it is the current default.
Once you have set the default color, it will remain the default color until the next
time you change it.
You can also change the highlight color by clicking on the color icon on the tool
bar
. Every time you click on the highlight color button it changes. The
color displayed is the color that will be used with the next highlight.

Extract

The powerful feature of “Highlight Extraction”
will search through your
document and find all the highlighted information and extract it into a new
document. You can extract all of the highlighted colors or just one. This new
document can be saved or read. The extraction process retains all formatting,
fonts and even pictures! For more information on highlight extraction, see the
Extracting Highlights later in this manual.

Cut
When you select Cut, it will remove the highlighted text from your document and
place it in the clipboard. The clipboard will hold this information until the next
cut command is activated. If you select Cut twice, only the last information will
be retained on the clipboard. The hot keys for Cut are CTRL+X
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Copy
The Copy feature is very similar to the Cut feature, except that it does not remove
the highlighted text from the document. Instead it makes a copy of it and places it
on the clipboard. The hot keys for Copy are CTRL+C.

Paste
When you use the Paste feature, it will paste whatever is on the clipboard into
your document. The information that is pasted from the clipboard will be placed
where your cursor is located in the document. To paste something from the
clipboard, hold down CTRL+V.

Select All
You can select the entire text of the document by holding down CTRL+A. This
will highlight the entire document. Be very careful with the entire text selected,
because if you press the wrong key, you could delete your entire document.

Summarize
The E-Text Reader has a built in document summarizer feature. This feature allows a
reader to reduce the contents of the document to its basic essentials. A language modeling
system is used to do the summary, giving it a higher degree of accuracy over the formula
driven models used in the summary feature of Microsoft Word. Because Premier uses
the language, modeling the summary will even be effective on fiction that does not
always have the formal paragraph structure used in non-fiction writings.

How to summarize a document
The summary feature is built into the E-Text Reader, so you must start the E-Text
Reader. Once the E-Text Reader has loaded, open your document. Once the
document is displayed, you will see the Support Toolbar.
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The icon on the far right of the Support Toolbar is the Summarize icon
.
You can select this icon or select Summarize from the edit menu. This will open
up the summarize window.

You have two choices of how you want the summary; you have one or the other
or both. They are Place Summary into a separate document, and Highlight
Summary in the original document.

Place Summary into a separate document.
When there is a check in the Place Summary into a separate document, a separate
document is created and the resulting summary is placed in it. This summary can
be saved or read independently of the original document.

Highlight Summary in the original document.
When the Highlight Summary in the original document has a check mark in it, the
summary sentences will be highlighted in the original document. When the
summary is done, you will be able to look at the original document and see
exactly where the sentences that were pulled into the summary came from.
There are four choices of colors that can be used by the summary. These colors
are Yellow, Blue, Pink and Green. These are the same colors used by the
Highlight and Extraction feature built into the E-Text Reader. This gives you a
big advantage over other summary tools because once the summary is done you
can go through, and add things to the summary, just by selecting the text you want
to add and then click on the high light color. To remove text from the summary

E-Text Reader

19

select the highlighted text you want to remove and then select Clear Highlights
from the edit menu.
This is the first summary tool that allows you to quickly modify the summary. If
you want, you can have the summary highlight in one color, and then switch
colors for your highlight, that way you will be able to easily distinguish what was
in the original and what was not. Once you are done highlighting and would like
to create a separate document that contains just the summary use the Extract
feature on the Support Toolbar.

Adjusting the summary size
You can control the size of the summary. For some document, you can create a
summary that is only 10 percent of the original document and some you will need
a larger summary. Adjusting the size of the summary will take a little practice to
meet your needs. To help with this you have two options, you can restrict the
summary to be a percentage of the original document, or it can be a specific
number of sentences.

The default setting is a percentage of the document. To switch between
percentages of the document to number of sentences just select the desired radio
button. Once you have made your selection, you can adjust your summary size.
You adjust the summary size simply by moving the slider to the left to make it
smaller, and to the right to make it larger. Just below the slider, you will see the
percentage or the number of sentences that will be included in the document.
When you have made the selections for your summary just select the Summarize
button and it will start the szummary. The summary process is pretty fast it can
summarize about 10 pages a second, so a 100-page document will take about 10
seconds.
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Insert Bookmark
The E-Text Reader has a bookmark feature. This bookmark feature allows you to
insert as many bookmarks into a document as you want. These work great for
marking points of interest in a documents as well as making where you left off, so
the next time you open the document you can quickly go back to that spot.
To insert a bookmark, go to the spot in the text where you want to insert a
bookmark and then press the F9 key or click on the Mark icon
insert a bookmark where the cursor is currently located.

. This will

Move To Prior Bookmark
The E-Text Reader will let you transverse through your bookmarks quickly by
pressing CTRL+F7 to go from your current location to a bookmark prior to your

current location. You can also click on the Prior Button on the toolbar

.

Move To Next Bookmark
To go to the next bookmark press CTRL+F8 this will move you to the next
closest bookmark from your current location. Keep pressing CTRL + F8 to go to

the next bookmark. You can also use the Next Button on the tool bar.

Find
You can search for a word or part of a word. To open the Find dialog box, click
on the binoculars
on the tool bar, or hold down CTRL+F. This will open
up the Find dialog box. In the “Find what” edit box, type in the word or partial
word you want to search for. Before you select the Find Next button, you have
two choices. (1) You can select the Match Case check box. If this is checked, the
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program will only search for words that match both spelling and case exactly. By
default, the Find feature will start searching from your current location in the
document to the end of the document. (2) If you want to search from your current
location to the beginning of the document, make sure the Search Up radio button
is selected. Select Find Next to find the first occurrence of the word, then
continue clicking on the Find Next until you have found all occurrences of that
word.

Spell Check
The spell checker has an English dictionary with over 100,000 words. To run
Spell Check, make sure the document you want to proof is displayed in the word
processor window. Start the Spell Check by selecting it from the Edit menu. You
will know it has been started when you see the dialog window as shown below.

The Spell Check dialog has one edit box, two list boxes and 11 buttons. The Spell
Check will go through the document until it finds a word that is not in the
dictionary. When it finds one, it will list all of the words that come close to
matching the word with the highest probable replacement first.
The Check-Spelling Dialog appears if a word requiring your attention is detected.
You can use the dialog box to specify whether the word should be ignored or
replaced.
Add button: Causes the reported word to be added to the dictionary selected in
the Add Words To list. Use the Add button if a correctly spelled word you use
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often is reported as a misspelling (e.g., your family name). If the word is not used
frequently, you may want to select the Ignore or Ignore All buttons instead.
Cancel button: Stops the current spell-checking operation.
Change button: Will change only THIS occurrence of the reported word to be
replaced. If the problem word was edited, the edited word is used as the
replacement. Otherwise, the selected suggestion is used as the replacement. If
you want only this occurrence of the word to be replaced, use the Change button.
If the reported word is one you frequently misspell, you might consider adding it
to a user dictionary via the User Dictionaries Dialog Box. You can display the
User Dictionaries dialog box by selecting the Dictionaries button.
Change All buttons: Will change this and all following occurrences of the
reported word to be replaced with the word in the Change To box. If you want
only this occurrence of the word to be replaced, use the Change button. If the
reported word is one you frequently misspell, you might consider adding the
misspelling and the correction to a user dictionary via the User Dictionaries
Dialog. You can display the User Dictionaries dialog by selecting the
Dictionaries button.
Suggestions: Contains a word, which may be misspelled or otherwise incorrect,
and is presented with a candidate replacement word. You can change the word by
selecting the Change button, or skip it by selecting the Ignore button. Note that
the label of this box changes to "Not in dictionary" when a misspelled word is
detected.
Ignore button: Causes this occurrence of a misspelled word to be skipped. If the
same misspelled word appears later, it will be reported.
Ignore All buttons: Causes this and all further occurrences of a misspelled word
to be skipped. You might use this button if the word reported as a misspelling is
actually spelled correctly. If the word is one you use frequently, you may wish to
ignore it permanently by selecting the Add button.

E-Text Reader

23

Reading a Document

To read a document, press the F6 Key or click on the read icon
. When
the reader starts, it will begin where the current cursor is located. To make sure
your cursor is at the beginning of the document, press CTRL+HOME, this will
put you at the beginning of the document. The system will continue until it
reaches the end of the document. To stop reading, press the F7 key. Press the F6
Key to resume where you left off.
To read one line at a time, use the Up or Down arrow. The system will read the
line that the cursor moved to.
If you want to spell out a word, use your Left and Right arrows. The system will
read the character that the cursor just moved over.

Read A word at A time
If you want to read a single word at a time, all you need to do is hold down the
Control Key and press the Left or Right Arrow key while you are holding down
the control key. This will read the Prior or Next word respectively.

Stop Reading
To stop the system from reading, press the F7 key or click on the stop icon

. If you want to continue where you left off, press the F6 Key.

Voice
The system comes with 5 standard voices. You can change the voices at any time
by pressing the F12 key.
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You can scroll through the list of voices until you find the one you want. As you
select a voice, the voice will be read to you so you can hear what the voice sounds
like.
Once you have selected the desired voice, you can adjust the Rate by moving the
first slide bar to the right for faster and left for slower. Select the Reset Button to
set everything back to the default settings. Both the Rate and Pitch can be
adjusted from a –10 to 10, with 0 being the default.
You adjust the Pitch just like changing the voice rate. Moving the slider to the
left will decrease the pitch, sliding it to the right increases the pitch. As both the
Rate and Pitch are being adjusted, you will hear what the new settings sound like.
Select the OK button to close the window and save the changes.
Selecting the Cancel button will close the window without saving any of the
changes.
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Translation Menu
There is only one menu item under Translate menu. To translate a document, follow
these simple steps:
1. Open a document or “cut and paste” some information into the E-Text Reader
document window.
2. Select Translate from the translation menu. This will open up the translation
window.
3. Select the language that you want to translate to:

4. Select the “Translate” button. This will start the translation process.

5. When the translation is complete, it will place the translated text into a separate
window, from which you can save or read.
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Settings Menu
The system will automatically save any setting that is changed. The system will
always ‘start up’ the same way it was shut down. There are no configuration files
to contend with.

Colors
The E-Text Reader comes with five different Color Settings:
(1)
(2)
(3)
(4)
(5)

White background with black text (this is the default)
A black background with white text
Blue background with yellow text
A black background with green text
White background with red text.

To select the desired color scheme, press Alt + T to go to the Settings Menu. Then
use the arrow key to go down to Colors. From the Colors sub menu, select the
desired color scheme. The active color scheme is the one that is checked.
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Zoom
The system is equipped with a zoom feature. The zoom feature allows users to
zoom from 25% to 400% of the current font. The reader will work at any
magnification level. The default setting is 100%. To zoom in or out, you must
select the Settings menu by pressing ALT+T. Then select Zoom from the menu.
This will open up the Zoom sub menu. This menu lists all of the available
percentages. Select the one you want and it will change immediately.
The Quickest way to zoom in on a document is to click on the Zoom Icon on the

toolbar
or press CTRL + Q. Every time you press the hotkey or click on
the Icon it will get larger until it gets to the largest setting, then if you press it one
more time it will go to the smallest setting. To get it to the setting you want, just
keep pressing the button and it will come back to the setting you want.

Help
This entire manual is also compiled into the Help file so that if you want to
quickly search for a topic you can. To activate the Help, just click on the help

icon

or Press F1

Hot Key List.
To see a complete list of the Hot Keys for the E-Text Reader, go to the Help menu
and then from the menu select the Hot Key List and a window will open with a
list of all the hot keys available within the E-Text Reader.
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About
If you ever want to find out what version of the E-text Reader you are using, just
go to the Help menu and select the About option. This will open up the About
menu and display the version number.
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Extracting Highlights.
The E-text Reader has a built-in highlighting feature that allows you to highlight any
information in one of 4 different colors: Yellow, Blue, Pink and Green. These highlight
colors are very unique and will not interfere with any other color in your document. This
makes it possible for the E-text Reader to distinguish between the highlighted text and
text that has a similar color background. The E-text Reader will allow you extract all the
highlight colors or just one.
The extracted information is placed in a separate document that you can then save or
have read to you. The information that is extracted into this new document is the same as
the original. The color, font and layout are all retained. The extract feature will even
import the pictures and graphics if they are included as part of the hightlighted document.
This document can be saved in one of 6 different formats including MS Word and RTF.
E-Text Reader creates a generic form of a MS Word document that that contains the
extracted information is compatible with all versions of MS Word.

How to extract text.
E-Text Reader will read almost any standard format (DOC (MS Word), RTF, TXT)
document on your computer. You can even cut and past information into it. Once you
have opened a document, you can then go through and highlight the information you
want. When that is complete click on the extract button or press the F3 key. You will be
presented with an Extract color window.

From the Extract Colors window you can then select the color or colors you want to
extract. When you are ready select the extract button and the E-text Reader will start
extracting the text. This process can take time depending on the size of your document.
When it is done the extracted information will be placed in the a Highlight preview
window.
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The extract window can read the information to you, or you can save it into a new
document.

Save As
You will see the Save as dialog box in two different situations. One is when you
have created a document but have not saved it yet. When you save a document for
the first time you must supply a file name, file type and a file location. By
default, when you create a new document it is given the name Untitled and the file
type is Microsoft Word, and the location is “My Documents”. If the location and
the type are OK, all you need to do is type in a file name. The name can be up to
255 characters long and be any combinations of letters and numbers. You do not
need to put an extension on the file (e.g. .doc or .txt); the system will
automatically do this for you based on the type of file selected.
If you attempt to give the file a name that already exists, you will get a prompt
asking you if you want to overwrite the existing one. If you select “Yes” the old
file will be gone.
You can also use the Save As to copy files. You can open a document and then
go to File, select Save As and give the document a new name. It does not remove
the old file; it only makes a copy of it.
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Close
There are safeguards built into the Close feature. If you try to close a document
that you have made changes to, you will be prompted to save the changes. If you
have not given the document a name, the Save As dialog box will appear,
prompting you to give the existing document a name. See the Save As section of
this manual for more information about the Save As function. A hot key for this
feature is CTRL+F4.

Clear All Highlighting
You can quickly remove all the highlighting from your extracted document by

on the tool bar. This
pressing CTRL + L or clicking on the Clear button
will remove all the highlighting and set the background color to white.

Cut
When you select Cut, it will remove the highlighted text from your document and
place it in the clipboard. The clipboard will hold this information until the next
cut command is activated. If you select Cut twice, only the last information will
be retained on the clipboard. The hot keys for Cut are CTRL+X

Copy
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The Copy feature is very similar to the Cut feature, except that it does not remove
the highlighted text from the document. Instead it makes a copy of it and places it
on the clipboard. The hot keys for Copy are CTRL+C.

Paste
When you use the Paste feature, it will paste whatever is on the clipboard into
your document. The information that is pasted from the clipboard will be placed
where your cursor is located in the document. To paste something from the
clipboard, hold down CTRL+V.

Select All
You can select the entire text of the document by holding down CTRL+A. This
will highlight the entire document. Be very careful with the entire text selected,
because if you press the wrong key, you could delete your entire document.

Find
You can search for a word or part of a word. To open the Find dialog box, click
on the binoculars on the tool bar, or hold down CTRL+F. This will open up the
Find dialog box. In the “Find what” edit box, type in the word or partial word
you want to search for. Before you select the Find Next button, you have two
choices. (1) You can select the Match Case check box. If this is checked, the
program will only search for words that match both spelling and case exactly. By
default, the Find feature will start searching from your current location in the
document to the end of the document. (2) If you want to search from your current
location to the beginning of the document, make sure the Search Up radio button
is selected. Select Find Next to find the first occurrence of the word, and then
continue clicking on the Find Next until you have found all occurrences of that
word.
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Reading a Document

To read a document, press the F6 Key or click on the read icon
. When the
reader starts, it will begin where the current cursor is located. To make sure your
cursor is at the beginning of the document, press CTRL+HOME, this will put you
at the beginning of the document. The system will continue until it reaches the
end of the document. To stop reading, press the F7 key. Press the F6 Key to
resume where you left off.
To read one line at a time, use the Up or Down arrow. The system will read the
line that the cursor moved to.
If you want to spell out a word, use your Left and Right arrows. The system will
read the character that the cursor just moved over.

Read a Word at a Time
If you want to read a single word at a time, all you need to do is hold down the
Control Key and press the Left or Right Arrow key while you are holding down
the control key. This will read the Prior or Next word respectively.

Stop Reading
To stop the system from reading, press the F7 key or click on the stop icon

. If you want to continue where you left off, press the F6 Key.

Voice
The system comes with 5 standard voices. You can change the voices at any time
by pressing the F12 key.
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You can scroll through the list of voices until you find the one you want. As you
select a voice, the voice will be read to you so you can hear what the voice sounds
like.
Once you have selected the desired voice, you can adjust the Rate by moving the
first slide bar to the right for faster and left for slower. Select the Reset Button to
set everything back to the default settings. Both the Rate and Pitch can be
adjusted from a –10 to 10, with 0 being the default.
You adjust the Pitch just like changing the voice rate. Moving the slider to the
left will decrease the pitch, sliding it to the right increases the pitch. As both the
Rate and Pitch are being adjusted, you will hear what the new settings sound like.
Select the OK button to close the window and save the changes.
Selecting the Cancel button will close the window without saving any of the
changes.
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